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Goals 

• Understand the flow of control and data when 
using ParaView Catalyst with a simulation code 
– Understand efficiency trade-offs 

• Hands-on exercises for: 
– Interfacing a simulation code with Catalyst 
– Creating VTK data structures to represent grid and 

field information from simulation data structures 
– Creating a Python script to extract data and 

screenshots through ParaView Catalyst  
• Running a simulation with all of the parts put 

together 
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Online Materials 

• This presentation and VM virtual appliance at: 
– www.paraview.org/Wiki/ParaView/Catalyst/SC14_Tutorial 

 
• Install ParaView 4.2 (not needed for tutorial) 

– www.paraview.org/download 

 
• Install VirtualBox 

– www.virtualbox.org 
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VirtualBox 

• Run VirtualBox and go to “File→Import 
Appliance…” 

• Click on “Open appliance…” and select “Copy of 
centos1.ova”, click on “Next >” 

• Can adjust appliance settings as needed and 
click on “Import” 
– Suggest keeping defaults 

• Click on “Start” to run VirtualBox with ParaView 
Catalyst tutorial examples 
– Can click on “OK” for warning messages 
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VirtualBox 

• Use catuser account 
– Password is “cat2014” 
– Account has sudo privileges for installing your own 

development environment 
• Get terminal by clicking Applications→Favorites 

→Terminal 
• ParaView GUI build is at 

/home/catuser/ParaView4.2/build/ 
• ParaView OSMesa build is at 

/home/catuser/ParaView4.2/build_mesa 
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Online Help 
• ParaView Catalyst User’s Guide: 

– http://paraview.org/Wiki/images/4/48/CatalystUsersGuide.pdf  

• Email list:  
– paraview@paraview.org  

• Doxygen: 
– http://www.vtk.org/doc/nightly/html/classes.html 
– http://www.paraview.org/ParaView3/Doc/Nightly/html/classes.html 

• Sphinx: 
– http://www.paraview.org/ParaView3/Doc/Nightly/www/py-doc/index.html  

• Websites: 
– http://www.paraview.org  
– http://catalyst.paraview.org 

• Examples:  
– https://github.com/acbauer/CatalystExampleCode  
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What is ParaView Catalyst? 
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What is ParaView Catalyst? 

• A set of in situ data analysis and visualization 
capabilities developed in response to current 
and near future data analysis challenges 
– Available today, open source 

• Challenges 
– There is an explosion of scientific data 
– “data analysis infrastructure and storage system 

bandwidth have not scaled proportionately to 
processing power” 
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ParaView Catalyst: Goals 
• Goals: 

– Provide flexible analysis options in addition to 
traditional ‘post-processing’ options 

• Integrated workflow with widely used tool set 
• Old options still available 

– Increase the value of data saved to permanent 
storage 

• Increased fidelity in time/space 

– Create framework for sampling and visualization R&D 
• Large scale sampling 
• Novel visualization options (ParaView Cinema, etc.) 

– Optimize I/O 
• Will continue to be under heavy constraints … 10 



System Parameter 2011 “2018” Factor Change 

System peak 2 PF 1 EF 500 

Power 6 MW ≤20 MW 3 

System Memory 0.3 PB 32-64 PB 33 

Node Performance 0.125 TF 1 TF 10 TF 8-80 

Node Concurrency 12 1,000 10,000 83-830 

Network BW 1.5 GB/s 100 GB/s 1,000 GB/s 66-660 

System Size (nodes) 18,700 1M 100k 50 

Total Concurrency 225 K 10 B 100 B 40k-400k 

Storage Capacity 15 PB 300-1,000 PB 20-67 

I/O BW 0.2 TB/s 20-60 TB/s 100-300 

Why In Situ? 
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Why In Situ? 
Need a supercomputer to analyze results from a 
hero run 
 
 
 
 
 
                           2 orders of magnitude difference 

between each level 
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Access to More Data 

Post-processing In situ processing 

CTH (Sandia) simulation with roughly equal data stored at simulation 
time 
 
Reflections and shadows added in post-processing for both examples 
 

Dump 
Times 
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Quick and Easy Run-Time Checks 
Expected wind stress field at the 
surface of the ocean 

Wind stress in new run, quick glance 
indicates we are using wrong wind 
stress 

MPAS-O (LANL) simulation 
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Faster Time to Solution 

CTH (Sandia) simulations comparing different workflows 
15 



Small Run-Time Overhead 
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Reduced File Size 

Rotorcraft simulation output size for a single time 
step 
• Full data set – 448 MB 
• Surface of blades – 2.8 MB 
• Image – 71 KB 

Helios (Army AFDD/AMRDEC) simulation 
17 



Reduced File IO Costs 

Time of 
Processing 

Type of 
File 

Size per File Size per 1000 
time steps 

Time per File 
to Write at 
Simulation 

Post Restart 1,300 MB 1,300,000 MB 1-20 seconds 

Post Ensight 
Dump 

200 MB 200,000 MB > 10 seconds 

In Situ  PNG .25 MB 250 MB < 1 second 

XRAGE (LANL) simulation 18 



 
Simulation 

 
 
 
 
 
 

Catalyst 

Disk 
Storage 

Visualization 

 
Simulation 

 
 
 
 
 
 

Catalyst 

Disk 
Storage 

Visualization 

Separate MPI 

Two Ways to Run in Batch 

In Situ In Transit 
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Run Interactively 

• Interactive to see current results from simulation 
• Access to pipeline on ParaView Catalyst server and 

client 
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ParaView Catalyst Architecture 

ParaView Catalyst 

Python Wrappings 

ParaView Server 
Parallel Abstractions and Controls 

VTK 
Core Visualization Algorithms 
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High Level View 
Simulation Developers 
• Pass necessary simulation 

data to ParaView Catalyst 
• Need sufficient knowledge 

of both codes 
– VTK for grids and field data 
– ParaView Catalyst libraries 

• Transparent to simulation 
users 

• Extensible  

Simulation Users 
• Knowledge of ParaView as 

a post-processing/analysis  
tool 
– Basic interaction with GUI 

Catalyst script generator  
plugin 

– Incremental knowledge 
increase to use the in situ 
tools from basic ParaView 
use 

• Programming knowledge 
can be useful to extend the 
tools 
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Developer Perspective 

Solver Catalyst 

Co-processing 
API Adaptor 

INITIALIZE() 
ADDPIPELINE(in pipeline) 
 
REQUESTDATADESCRIPTION(in time, out 
fields) 
COPROCESS(in vtkDataSet) 
 
FINALIZE() 

function 
calls 

function 
calls 

INITIALIZE(in pipelines) 
 
COPROCESS(in time, in grid, in fields) 
 
FINALIZE() 
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Simulation 

Catalyst 

# Create the reader and set the filename.  
reader = servermanager.sources.Reader(FileNames=path) 
view = servermanager.CreateRenderView() 
repr = servermanager.CreateRepresentation(reader, view) 
reader.UpdatePipeline() 
dataInfo = reader.GetDataInformation() 
pDinfo = dataInfo.GetPointDataInformation() 
arrayInfo = pDInfo.GetArrayInformation("displacement9") 
if arrayInfo: 
  # get the range for the magnitude of displacement9  
  range = arrayInfo.GetComponentRange(-1) 
  lut = servermanager.rendering.PVLookupTable() 
  lut.RGBPoints  = [range[0], 0.0, 0.0, 1.0, 
                    range[1], 1.0, 0.0, 0.0] 
  lut.VectorMode = "Magnitude"  
  repr.LookupTable = lut 
  repr.ColorArrayName = "displacement9" 
  repr.ColorAttributeType = "POINT_DATA" 

Statistics 

Polygonal Output 
with Field Data 

Script Export 

Augmented 
script in 
input deck. 

Rendered Images 

Output 
Processed 
Data 

User Perspective 

Series Data 
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User & Developer Perspective 
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ParaView Catalyst for 
Simulation Developers 
 



Developers Section Overview 

• Most work is done in creating the adaptor 
between the simulation code and Catalyst 

• Small footprint in main simulation code base 
• Needs to be efficient both in memory and 

computationally 
• Fortran, C++ and Python examples 

– Fortran – 
~/Examples/CatalystExampleCode/FortranPoissonSolver 

– C++ – ~/Examples/miniFE-2.0_ref_Catalyst 
– Python – 

~/Examples/CatalystExampleCode/PythonDolfinExample 
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Interaction Overview 

• Simulation has separate data structures from 
VTK data structures 

• Use an adaptor to bridge the gap 
– Try to reuse existing memory 
– Also responsible for other interactions between 

simulation code and Catalyst 

Solver Adaptor 
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Interaction Overview 

• Functional interface – typically 3 calls between 
simulation code and adaptor 
– Initialize 
– CoProcess 
– Finalize 

Solver Adaptor 
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Adaptor Overview 

• Creates VTK data objects representing 
simulation data 

• Creates Catalyst pipelines 
– Information on how to process VTK data objects to 

get desired output 
 

Adaptor 
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Finalize Overview 

• Last chance to do something 
• Clean up any allocated memory 
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Information Needed By Adaptor During 
Initialization 

• What pipelines to use? 
– Canned pipelines – pre-built pipelines that take in a 

few parameters (e.g. slice output with output file 
name, frequency and slice normal and origin) 

– Python pipelines – generated in the ParaView GUI 
and potentially edited 

• Optionally 
– Information to construct grids and fields 
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Information Needed By Adaptor During 
CoProcess 

• Time, time step 
• Optionally 

– Information to construct grids and fields if not passed 
in during initialization step 

– Force all pipelines to execute (simulation may know 
something important has happened) 

– Other information to add in extra logic to pipelines 
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VTK Preliminaries 
• Many objects in VTK are reused so we use reference 

counting to keep track of how many other objects are 
using them 
– New() – creates a new object in dynamic memory and sets 

reference count to 1 
– Delete() – reduces reference count by 1 and if reference count 

goes to 0 then object gets deleted 
– a->Set*(b), a->Add*(b) – b’s reference count gets increased by 1 

 

vtkDoubleArray* a = vtkDoubleArray::New(); // a’s ref count = 1 
vtkPointData* pd = vtkPointData::New();         // pd’s ref count = 1 
pd->AddArray(a);                                               // a’s ref count = 2 
a->Delete();                                                         // a’s ref count = 1 
a->SetName(“an array”);                      // valid as a hasn’t been deleted 
pd->Delete();                                        // deletes both pd and a 
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VTK Preliminaries (Python) 
• The whole API is available in Python, though 

syntax is different 
• All variables are references 
• An object is deleted when no variable references 

it anymore 
• No need for smart pointers 

a = vtk.vtkDoubleArray()  # a’s ref count = 1 
pd = vtk.vtkPointData()  # pd’s ref count = 1 
pd.AddArray(a)   # a’s ref count = 2 
a = None    # array’s ref count = 1 but a doesn’t reference it 
a.SetName(“an array”)  # invalid as a doesn’t reference the array 
pd.GetArray(0).SetName(“an array”)  # valid since array still exists 
pd = None   # deletes both pd and the array 
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Helpful VTK Objects 

• vtkSmartPointer<vtkObject*> 
– Deals with creating and deleting vtkObjects 
– Increases reference count when set 
– Reduces reference count when it gets deleted or 

unset 
vtkPointData* pd = vtkPointData::New();             // pd’s ref count = 1 
{ 
  vtkSmartPointer<vtkDoubleArray> a =  
    vtkSmartPointer<vtkDoubleArray>::New(); 
  pd->AddArray(a); 
} 
// a no longer exists but the generated vtkDoubleArray does 
vtkSmartPointer<vtkPointData> pd2 = pd;               // pd’s ref count = 2 

http://www.vtk.org/doc/nightly/html/classvtkSmartPointer.html 
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Helpful VTK Objects (2) 

• vtkNew<vtkObject*> 
– Deals with creating and deleting vtkObjects 
– Reduces reference count when it gets deleted 
– Need GetPointer() when a method needs a vtkObject 

vtkPointData* pd = vtkPointData::New() ;       // pd’s ref count = 1 
{ 
  vtkNew<vtkDoubleArray> a; 
  pd->AddArray(a.GetPointer());       // need GetPointer() here and not just a 
} 
// a no longer exists but the generated vtkDoubleArray does 

http://www.vtk.org/doc/nightly/html/classvtkNew.html 
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Writing the Initialization Method 

• Assuming we will pass in data to create VTK grid 
and field data objects during CoProcess call 

• ParaView classes to look at: 
– vtkCPProcessor – main manager object 
– vtkCPPipeline and vtkCPPythonScriptPipeline – 

object to control Catalyst pipeline (typically one object 
per pipeline) 

http://www.paraview.org/ParaView3/Doc/Nightly/html/classvtkCPProcessor.html 
 
http://www.paraview.org/ParaView3/Doc/Nightly/html/classvtkCPPythonScriptPipeline.html  
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vtkCPProcessor Initialization Step 

• vtkCPProcessor 
– vtkCPProcessor* New() 

• Static constructor method that sets reference count to 1 

– void Delete() 
• Reduce reference count by 1 (not necessarily delete though) 

– int Initialize() 
• Returns 1 for success and 0 for failure 

– int AddPipeline(vtkCPPipeline* pipeline) 
• Pass in a vtkCPPipeline object, vtkCPProcessor will keep 

reference to pipeline so it won’t get deleted 
• Returns 1 for success and 0 for failure 

• Will go through other important vtkCPProcessor 
methods later 
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vtkCPProcessor Initialization Step 

For ParaView 4.2, can initialize Catalyst with a separate 
MPI communicator 
• Use “int 

Initialize(vtkMPICommunicatorOpaqueComm*)” 
instead of “int Initialize()” 

• vtkMPICommunicatorOpaqueComm defined in 
vtkMPI.h 

• Use constructor 
vtkMPICommunicatorOpaqueComm(MPI_Comm*) 
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vtkCPPipeline Initialization Step 

• vtkCPPipeline 
– Abstract class – methods are usually only called by 

vtkCPProcessor 
• vtkCPPythonScriptPipeline 

– Concrete class that derives from vtkCPPipeline 
– vtkCPPythonScriptPipeline* New() 

• Static constructor method that sets reference count to 1 

– int Initialize(const char *fileName) 
• fileName is the Python script pipeline which can include a 

relative or absolute path 
• Returns 1 for success and 0 for failure 
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vtkCPProcessor Finalize Step 

• vtkCPProcessor 
– int Finalize() 
– Delete the vtkCPProcessor object 

 
• If ParaView was built with DEBUG_LEAKS_ON, 

will get messages that VTK objects were not 
deleted before exiting.  
– Most likely from not deleting vtkCPProcessor, 

vtkCPipeline or VTK objects created in the adaptor 
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Configuring with CMake 

• Configuring the build is simplified by using 
CMake 
– Determines dependencies automatically for compiling 

(location of header files & modules) and linking 
(location of libraries) 

• Typically use ccmake for terminal-based 
interface 
– Often building on a remote machine 
– Command in build directory: ccmake <path to source 

dir> <preset configuration options> 
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Fortran90 Example 1 – Write It! 

• Interface in: 
– ~/ParaView4.2/ParaView/CoProcessing/PythonCatalyst/ 
       CPythonAdaptorAPI.h  
– ~/ParaView4.2/ParaViewCoProcessing/Catalyst/CAdaptor.API.h 

• Assume Python scripts for pipeline specifications 
are passed in as command line arguments 

• Starting file: 
– ~/Examples/CatalystExampleCode/ 
       FortranPoissonSolver/FEFortranAdaptor.F90 
– Subroutine signatures: 

• initializecoprocessor() 
• finalizecoprocessor() 
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Fortran90 Example 1 – A Solution 

  subroutine initializecoprocessor() 
    implicit none 
    integer :: ilen, i 
    character(len=200) :: arg 
 
    call coprocessorinitialize() 
    do i=1, iargc() 
       call getarg(i, arg) 
       ilen = len_trim(arg) 
       arg(ilen+1:) = char(0) 
       call coprocessoraddpythonscript(arg, ilen) 
    enddo 
  end subroutine initializecoprocessor 

subroutine finalizecoprocessor() 
  call coprocessorfinalize() 
end subroutine finalizecoprocessor 
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~/Examples/CatalystExampleCode/FortranPoissonSolver/ 
   example1/FEFortranAdaptor.F90 



C++ Example 1 – Write It! 
• Assume Python scripts for pipeline specifications 
• Starting file: 

– ~/Examples/miniFE-
2.0_ref_Catalyst/adapter/catalyst_adapter.cpp 

– Function signatures: 
• int initialize(miniFE::Parameters& params) 

– Python script names in params.script_names which is type std::vector<std::string>  
– Processor in anonymous namespace 

• int finalize() 
 

• CMake configuration step in ~/Examples/miniFE-
2.0_ref_Catalyst/adapter_build 
– ccmake ../adapter -

DParaView_DIR:PATH=~/ParaView4.2/build_mesa 
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C++ Example 1 – A Solution 

void initialize(miniFE::Parameters& params) 
{ 
    Processor = vtkCPProcessor::New(); 
    Processor->Initialize(); 
    for(std::vector<std::string>::const iterator 
        it=params.script_names.begin(); 
        it!=params.script_names.end();it++) { 
      vtkCPPythonScriptPipeline* pipeline = 
        vtkCPPythonScriptPipeline::New(); 
      pipeline->Initialize(it->c_str()); 
      Processor->AddPipeline(pipeline); 
      pipeline->Delete(); 
      } 
  } 

void finalize() 
  { 
    if(Processor)  
      Processor->Finalize(); 
      Processor->Delete(); 
      Processor = NULL; 
      } 
  } 
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~/Examples/miniFE-2.0_ref_Catalyst/adapter/examples/ 
  example1_catalyst_adaptor.cpp 



Python Example 1 – Write It! 
• Uses a python demo from dolfin 1.3.0 

http://fenicsproject.org/documentation/dolfin/dev/python 
• Starting file: 

~/Examples/CatalystExampleCode/PythonDolfinExample/simulation.py 

• Import paraview, vtk and other needed packages 
• Load the pipeline definition script 
• To run the simulation 

– from <build_dir>/PythonDolfinExample 
– Type ./run-original.sh to execute unmodified simulation 
– or ./run-catalyst-step1.sh to execute solution 1 

 

http://fenicsproject.org/documentation/dolfin/dev/python


Python Example 1 – A Solution 

# initialize and read input parameters 

paraview.options.batch = True 

paraview.options.symmetric = True 

# import user co-processing script 

scriptpath, scriptname = os.path.split(sys.argv[1]) 

sys.path.append(scriptpath) 

if scriptname.endswith(".py"): 

    print 'script name is ', scriptname 

    scriptname = scriptname[0:len(scriptname)-3] 

try: 

    cpscript = __import__(scriptname) 

except: 

    print sys.exc_info() 

    sys.exit(1) 

import sys 

import paraview 

import paraview.vtk as vtk 

import paraview.simple as pvsimple 

import vtkPVCatalystPython 

import os 

~/Examples/CatalystExampleCode/PythonDolfinExample/simulation-catalyst-step1.py 



Writing the CoProcess Method 

• Assuming we will pass in data to create VTK grid 
and field data objects during CoProcess call 

• ParaView classes to look at: 
– vtkCPProcessor – main manager object 
– vtkCPDataDescription 

http://www.paraview.org/ParaView3/Doc/Nightly/html/classvtkCPDataDescription.html 50 



Writing the CoProcess Method 

Main section with 2 stages 
• First stage 

– Check with Catalyst pipelines to see if there is 
anything to do 

– Should check after every time step 
– Should be very fast 

• Second stage 
– Only done if at least one Catalyst pipeline wants to do 

something this time step 
– Construct needed input (i.e. VTK grids and fields) 
– Execute the pipelines that need to do something 
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Writing the CoProcess Method: First 
Stage 

• ParaView classes to look at: 
– vtkCPProcessor – main manager object 
– vtkCPDataDescription – meta-description of what 

simulation is able to provide 
• Simulation state 
• Pipeline sources 
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vtkCPProcessor CoProcess Step: First 
Stage 
• vtkCPProcessor 

– int RequestDataDescription(vtkCPDataDescription*) 
• Have the processor check if any Catalyst pipelines need to 

execute this time step 
• Returns 1 if a pipeline needs to execute and 0 otherwise 

• vtkCPDataDescription 
– void AddInput(const char* name) 

• Specify source of pipelines 
• Convention for single input is name=“input” 

– void SetTimeData(double time, vtkIdType timeStep) 
• Set the current simulation time and time step 

– void ForceOutputOn()/SetForceOutput() – optional 
• Specify that all Catalyst pipelines should execute 
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Fortran90 Example 2 – Write It! 

• Subroutine signature: 
– runcoprocessor(dimensions, step, time, x)  

• Starting file: 
– ~/Examples/CatalystExampleCode/ 
       FortranPoissonSolver/FEFortranAdaptor.F90 
– Only need to use step and time for this part 

 
• Fortran interface at: 

~/ParaView4.2/ParaView/CoProcessing/Catalyst/   
       CAdaptorAPI.h 
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Fortran90 Example 2 – A Solution 

 subroutine runcoprocessor(dimensions, step, time, x) 
    use iso_c_binding 
    implicit none 
    integer, intent(in) :: dimensions(3), step 
    real(kind=8), dimension(:), intent(in) :: x 
    real(kind=8), intent(in) :: time 
    integer :: flag, extent(6) 
    real(kind=8), DIMENSION(:), allocatable :: xcp(:) 
 
    call requestdatadescription(step,time,flag) 
    if (flag .ne. 0) then 
        call getvtkextent(dimensions, extent) 
 
       ! x is the array with global values, we need just this process's 
       ! values for Catalyst which will be put in xcp 
       allocate(xcp((extent(2)-extent(1)+1)*(extent(4)-extent(3)+1)*(extent(6)-extent(5)+1))) 
       call getlocalfield(dimensions, extent, x, xcp) 
 
       deallocate(xcp) 
    end if 
  end subroutine runcoprocessor 
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C++ Example 2 – Write It! 

• Function signature: 
– void coprocess(const double spacing[3], const Box& 

global_box, const Box& local_box,                 
std::vector<double>& minifepointdata, int time_step, 
double time, bool force_output); 
 

• Starting file: 
– ~/Examples/miniFE-2.0_ref_Catalyst/adapter/ 
       catalyst_adapter.cpp 
– Only need to use time_step, time and force_output for 

this part 
56 



C++ Example 2 – A Solution 

void coprocess(const double spacing[3], const Box& global_box, 
  const Box& local_box, std::vector<double>& minifepointdata, 
  int time_step, double time, bool force_output) 
{ 
  vtkSmartPointer<vtkCPDataDescription> dataDescription = 
      vtkSmartPointer<vtkCPDataDescription>::New(); 
  dataDescription->AddInput("input"); 
    dataDescription->SetTimeData(time, time_step); 
  dataDescription->SetForceOutput(force_output); 
  if(Processor->RequestDataDescription(dataDescription) == 0) 
    { 
     return; 
     } 
… 
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~/Examples/miniFE-2.0_ref_Catalyst/adapter/examples/ 
   example2_catalyst_adaptor.cpp 
 



Python Example 2 – Write It! 

• Function signature: 
– coProcess(grid, time, step) 

• grid : a VTK data object, in this example a vtkUnstructuredGrid 
• time : a real value defining the physical time 
• step : the timestep, i.e. the computation iteration number 

 

• Starting file: 
– simulation-catalyst-step1.py (or your own solution) 
– Only need to use time and step for this part 

 



Python Example 2 – A Solution  

def coProcess(grid, time, step): 

    # initialize data description 

    datadescription = vtkPVCatalystPython.vtkCPDataDescription() 

    datadescription.SetTimeData(time, step) 

    datadescription.AddInput("input") 

    cpscript.RequestDataDescription(datadescription) 

    . . . 

 

~/Examples/CatalystExampleCode/PythonDolfinExample/simulation-catalyst-step2.py 



Writing the CoProcess Method: Second 
Stage 

• ParaView classes to look at: 
– vtkCPProcessor – main manager object 
– vtkCPDataDescription – meta-description of what 

simulation is able to provide 
– vtkCPInputDataDescription – Catalyst description of 

what it needs in order to execute a pipeline 
• Each input type has a vtkCPInputDataDescription (e.g. one 

for every physics type in a multi-physics simulation, analysis 
and debug, etc.) 

http://www.paraview.org/ParaView3/Doc/Nightly/html/classvtkCPInputDataDescription.html 60 



vtkCPProcessor CoProcess Step: 
Stage Two 
• vtkCPProcessor 

– int CoProcess(vtkCPDataDescription*) 
• Have the coprocessor execute the desired Catalyst pipelines 
• Returns 1 for success and 0 for failure 

• vtkCPDataDescription 
– vtkCPInputDataDescription* 

GetInputDescriptionByName(const char* name) 
• Given an input name (“input”), get the input description object 

to determine what is needed 

• vtkCPInputDataDescription 
– void SetGrid(vtkDataObject*) 

• Set the VTK data source object for a Catalyst pipeline 61 



Fortran90 Example 3 – Write It! 

• Subroutine signature: 
– runcoprocessor(dimensions, step, time, x)  

• Starting files: 
– ~/Examples/CatalystExampleCode/ 
       FortranPoissonSolver/FEFortranAdaptor.F90 
– ~/Examples/CatalystExampleCode/ 
       FortranPoissonSolver/FECxxAdaptor.cxx 

 
• Fortran interface at: 

~/ParaView4.2/ParaView/CoProcessing/Catalyst/ 
       CAdaptorAPI.h 
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Fortran90 Example 3 – A Solution (1/2) 

subroutine runcoprocessor(dimensions, step, time, x) 
    use iso_c_binding 
    implicit none 
    integer, intent(in) :: dimensions(3), step 
    real(kind=8), dimension(:), intent(in) :: x 
    real(kind=8), intent(in) :: time 
    integer :: flag, extent(6) 
    real(kind=8), DIMENSION(:), allocatable :: xcp(:) 
 
    call requestdatadescription(step,time,flag) 
    if (flag .ne. 0) then 
       call needtocreategrid(flag) 
       call getvtkextent(dimensions, extent) 
 
       if (flag .ne. 0) then 
          call createcpimagedata(dimensions, extent) 
       end if 
       … 
  end if 
end subroutine runcoprocessor 
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~/Examples/CatalystExampleCode/FortranPoissonSolver/ 
   example3/FEFortranAdaptor.F90 



Fortran90 Example 3 – A Solution (2/2) 

64 

extern "C" void createcpimagedata_(int* dimensions, int* extent) 
{ 
  if (!vtkCPPythonAdaptorAPI::GetCoProcessorData()) 
    { 
    vtkGenericWarningMacro("Unable to access CoProcessorData."); 
    return; 
    } 
 
  // The simulation grid is a 3-dimensional topologically and geometrically 
  // regular grid. In VTK/ParaView, this is considered an image data set. 
  vtkSmartPointer<vtkImageData> grid = vtkSmartPointer<vtkImageData>::New(); 
 
  // Name should be consistent between here, Fortran and Python client script. 
  vtkCPPythonAdaptorAPI::GetCoProcessorData()->GetInputDescriptionByName("input")-
>SetGrid(grid); 
} 
 

~/Examples/CatalystExampleCode/FortranPoissonSolver/ 
   example3/FECxxAdaptor.cxx 



C++ Example 3 – Write It! 
• Still using function signature: 

– void coprocess(const double spacing[3], const Box& 
global_box, const Box& local_box,                 
std::vector<double>& minifepointdata, int time_step, 
double time, bool force_output); 

– Create a vtkImageData object that we’ll set up later 
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C++ Example 3 – A Solution 

void coprocess(const double spacing[3], const Box& global_box, 
  const Box& local_box, std::vector<double>& minifepointdata, 
  int time_step, double time, bool force_output) 
{ 
  vtkSmartPointer<vtkCPDataDescription> dataDescription = 
      vtkSmartPointer<vtkCPDataDescription>::New(); 
  dataDescription->AddInput("input"); 
    dataDescription->SetTimeData(time, time_step); 
  dataDescription->SetForceOutput(force_output); 
  if(Processor->RequestDataDescription(dataDescription) == 0) 
    { 
     return; 
     } 
  vtkNew<vtkImageData> grid; 
  dataDescription->GetInputDescriptionByName("input")->SetGrid(grid.GetPointer()); 
  Processor->CoProcess(dataDescription); 
… 
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~/Examples/miniFE-2.0_ref_Catalyst/adapter/examples/ 
   example3_catalyst_adaptor.cpp 
 



Python Example 3 – Write It! 
• Still using the same function signature 
 coProcess(grid, time, step) 

• Pass the given grid to the data description 
• Call coProcess after each computing step 



Python Example 3 – A Solution 
def coProcess(grid, time, step): 

    # initialize data description 

    datadescription = vtkPVCatalystPython.vtkCPDataDescription() 

    datadescription.SetTimeData(time, step) 

    datadescription.AddInput("input") 

    cpscript.RequestDataDescription(datadescription) 

    inputdescription = datadescription.GetInputDescriptionByName("input") 

    if inputdescription.GetIfGridIsNecessary() == False: 

        return  

    inputdescription.SetGrid(grid) 

    cpscript.DoCoProcessing(datadescription) 

 
while tstep < maxtimestep: 

    . . . 

    coProcess(ugrid,t,tstep) 

    u0.assign(u1) 

    t += dt 

    tstep += 1 

Finally, insert a call to coProcess in 
the compute loop … 

~/Examples/CatalystExampleCode/PythonDolfinExample/simulation-catalyst-step3.py 



Writing the CoProcess Method: Second 
Stage 

• VTK classes to look at: 
– Depends on simulation’s grid type 
– Classes that derive from: 

• vtkDataObject for grids 
• vtkAbstractArray for fields 
• vtkFieldData for managing vtkAbstractArrays  

– Other useful classes: 
• vtkCellType – types of cells for unstructured grids 

(vtkPolyData and vtkUnstructuredGrid) 

• Can look at readers or sources that provide the 
same type of VTK data object 
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Getting Data Into Catalyst 
• Main object will derive from vtkDataObject 

– Grids that derive from vtkDataSet  
– Multiblock grids that contain multiple vtkDataSets 

 

• Field (aka attribute) information 
– Point data – information specified for each point in a 

grid 
– Cell data – information specified for each cell in a grid 
– Field data – meta-data not associated with either points 

or cells 
 

• All object groups are 0-based/C/C++ indexing 
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vtkDataSet Subclasses  
vtkImageData 

vtkUniformGrid vtkPolyData 

vtkStructuredGrid vtkUnstructuredGrid 

vtkRectilinearGrid 

http://www.vtk.org/doc/nightly/html/classvtkDataSet.html 
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vtkDataSet Class Hierarchy 

 
 
 
 
 

 
 
Topologically regular grid 
Irregular geometry 
Supports blanking 
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Topologically Regular Grids 
• vtkImageData/vtkUniformGrid, vtkRectilinearGrid 

and vtkStructuredGrid 
 

• Topological structure defined by whole extent 
– Gives first and last point in each logical direction 
– Not required to start at 0 
 

• Partitioning defined by extents 
– First and last point in each logical direction of part of 

the entire grid (xmin, xmax, ymin, ymax, zmin, zmax) 
 

• Ordering of points and cells is fastest in logical 
x-direction, then y-direction and slowest in z-
direction  
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Extents 
• Whole extent for all processes (0, 8, 0, 6, 0, 0) 
• Extents different for each process 

– Rank 0: (0, 2, 0, 6, 0, 0), 21 points, 12 cells 
– Rank 1: (2, 8, 0, 3, 0, 0), 28 points, 18 cells 
– Rank 2: (2, 8, 3, 6, 0, 0), 28 points, 18 cells 
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Extents 

• Point and cell indices for extent of (2, 8, 3, 6, 0, 0) 
– From rank 2 in previous slide 
– 28 points and 18 cells 
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vtkImageData/vtkUniformGrid 
• vtkCPInputDataDescription::SetWholeExtent() – 

total number of points in each direction 
• SetExtent() – a process’s part of the whole extent 
• SetSpacing() – cell lengths in each direction 

(same for all processes) 
• SetOrigin() – location of point at i=0, j=0, k=0 

(same for all processes) 
 

• vtkUniformGrid 
– Supports cell blanking 
– Currently written to file as vtkImageData 

 
 

 

http://www.vtk.org/doc/nightly/html/classvtkUniformGrid.html 
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Fortran90 Example 4 – Write It! 

• Function signature: 
– extern "C" void createcpimagedata_(int* dimensions,    
        int* extent) 

• Starting file: 
– ~/Examples/CatalystExampleCode/ 
       FortranPoissonSolver/FECxxAdaptor.cxx 
– Local extent is contained in extent: 

• Points range from extent[0] to extent[1] in X-direction, extent[2] 
to extent[3] in Y-direction, extent[4] to extent[5] in Z-direction 

– Global extent can be determined from dimensions: 
• dimensions only has the maximum extent for each direction 
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Fortran90 Example 4 – A Solution 

extern "C" void createcpimagedata_(int* dimensions, int* extent) 
{ 
  if (!vtkCPPythonAdaptorAPI::GetCoProcessorData()) 
    { 
    vtkGenericWarningMacro("Unable to access CoProcessorData."); 
    return; 
    } 
 
  // The simulation grid is a 3-dimensional topologically and geometrically 
  // regular grid. In VTK/ParaView, this is considered an image data set. 
  vtkSmartPointer<vtkImageData> grid = vtkSmartPointer<vtkImageData>::New(); 
 
  grid->SetExtent(extent[0]-1, extent[1]-1, extent[2]-1, 
                  extent[3]-1, extent[4]-1, extent[5]-1); 
  grid->SetSpacing(1./(dimensions[0]-1), 1./(dimensions[1]-1), 1./(dimensions[2]-1)); 
 
  // Name should be consistent between here, Fortran and Python client script. 
  vtkCPPythonAdaptorAPI::GetCoProcessorData()->GetInputDescriptionByName("input")->SetGrid(grid); 
  vtkCPPythonAdaptorAPI::GetCoProcessorData()->GetInputDescriptionByName("input")->SetWholeExtent( 
    0, dimensions[0]-1, 0, dimensions[1]-1, 0, dimensions[2]-1); 
} 
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~/Examples/CatalystExampleCode/FortranPoissonSolver/ 
   example4/FECxxAdaptor.cxx 



C++ Example 4 – Write It! 

• Still using function signature: 
– void coprocess(const double spacing[3], const Box&   

global_box, const Box& local_box,                 
std::vector<double>& minifepointdata, int time_step, 
double time, bool force_output); 

– Local extent is contained in local_box: 
• Points range from local_box[0][0] to local_box[0][1] in X-

direction, local_box[1][0] to local_box[1][1] in Y-direction, 
local_box[2][0] to local_box[2][1] in Z-direction 

– Global extent is contained in global_box: 
• Points range from global_box[0][0] to global_box[0][1] in X-

direction, global_box[1][0] to global_box[1][1] in Y-direction, 
global_box[2][0] to global_box[2][1] in Z-direction 
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C++ Example 4 – A Solution 

… 
  vtkNew<vtkImageData> grid; 
  int extent[6] = {local_box[0][0], local_box[0][1], local_box[1][0], 
                     local_box[1][1], local_box[2][0], local_box[2][1]}; 
  grid->SetExtent(extent); 
  grid->SetSpacing(spacing[0], spacing[1], spacing[2]); 
  grid->SetOrigin(0, 0, 0); 
  dataDescription->GetInputDescriptionByName("input")->SetGrid(grid.GetPointer()); 
  int wholeExtent[6] = {global_box[0][0], global_box[0][1], global_box[1][0], 
                          global_box[1][1], global_box[2][0], global_box[2][1]}; 
  dataDescription->GetInputDescriptionByName("input")-> 
      SetWholeExtent(wholeExtent); 
… 80 

~/Examples/miniFE-2.0_ref_Catalyst/adapter/examples/ 
   example4_catalyst_adaptor.cpp 
 



Python Example 4 – Write It! 

• We treat only the unstructured grid case 
• Be aware of efficiency issues with python 
• Proposed solution is not optimal 
• Write a function that parses a Dolfin mesh 

description and builds out a vtkUnstructuredGrid 



Python Example 4 – A Solution 
def Mesh2VTKUGrid(mesh): 
    npoints = mesh.num_vertices() ; geom = mesh.geometry() 

    pts=vtk.vtkPoints() ; pts.SetNumberOfPoints(npoints) 

    for i in xrange(npoints): 

 p=geom.point(i) 

 pts.SetPoint(i,p.x(),p.y(),p.z()) 

    dim = mesh.topology().dim() ; ncells = mesh.num_cells() 

    cells = vtk.vtkCellArray() 

    cellTypes = vtk.vtkUnsignedCharArray() 

    cellTypes.SetNumberOfTuples(ncells) 

    cellLocations = vtk.vtkIdTypeArray() 

    cellLocations.SetNumberOfTuples(ncells) 

    loc=0 

    for (cell,i) in zip(mesh.cells(),xrange(ncells)) : 

 ncellpoints=len(cell) ; cells.InsertNextCell(ncellpoints) 

 for cpoint in cell: cells.InsertCellPoint(cpoint) 

 cellTypes.SetTuple1(i,vtkcelltypes[dim][ncellpoints]) 

 cellLocations.SetTuple1(i,loc) ; loc+=1+ncellpoints 

    ugrid = vtk.vtkUnstructuredGrid() 

    ugrid.SetPoints(pts) ; ugrid.SetCells(cellTypes,cellLocations,cells) 

return ugrid 

~/Examples/CatalystExampleCode/PythonDolfinExample/simulation-catalyst-step4.py 



vtkRectilinearGrid 
• vtkCPInputDataDescription::SetWholeExtent() – 

total number of points in each direction 
• SetExtents() – a process’s part of the whole 

extent 
• Set<X,Y,Z>Coordinates() – point coordinates in 

each direction 
– Only values for process’s extents 
– Index starting at 0 

 
 

http://www.vtk.org/doc/nightly/html/classvtkRectilinearGrid.html 
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vtkPointSet 
• Abstract class for grids with arbitrary point locations 

– Derived classes: vtkStructuredGrid, vtkPolyData, 
vtkUnstructuredGrid 

• SetPoints(vtkPoints*) – set the number and coordinates 
of a process’s points 

• vtkPoints 
– Class used to store actual point location  

array 
– C/C++ indexing 
– SetDataTypeTo<Int,Float,Double>() 
– SetNumberOfPoints() – allocation 
– SetPoint() – fast but doesn’t do bounds checking 
– InsertPoint()/InsertNextPoint() – safe but does bounds checking 

and reallocation as needed 

 
http://www.vtk.org/doc/nightly/html/classvtkPointSet.html 
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vtkStructuredGrid 
• vtkCPInputDataDescription::SetWholeExtent() – 

total number of points in each direction 
• SetExtents() – a process’s part of the whole 

extent 
• Ordering for points and cells 

– Fastest in x-direction 
– Next in y-direction 
– Slowest in z-direction 
– vtkPoints must be ordered in same manner 

 
 

 http://www.vtk.org/doc/nightly/html/classvtkStructuredGrid.html 
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vtkCell Straight-Edged Types 

http://www.vtk.org/doc/nightly/html/classvtkCell.html 
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vtkCell Curvilinear-Edge Types 
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vtkPolyData Cells 
• Efficient way – build through vtkCellArray 

– vtkCellArray::SetNumberOfCells() 
– Done for verts, lines, polys, triangle strips 

 

• Simple way – build through poly data API 
– Allocate() 
– InsertNextCell() 
– Squeeze() – reclaim unused memory 

 
• Cells are ordered by their insertion order 

 

http://www.vtk.org/doc/nightly/html/classvtkPolyData.html 
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vtkUnstructuredGrid Cells 
• Order of cells is order of insertion  

– 0-based indexing 
• Allocate() 
• InsertNextCell() 
• SetCells() 
• Squeeze() 
• Inserted points of cells are 0-

based indexing 
 
 
 

http://www.vtk.org/doc/nightly/html/classvtkUnstructuredGrid.html 
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Example 5 – Write It! 

• Still using function signature: 
– void coprocess(const double spacing[3], const Box& 

global_box, const Box& local_box,                 
std::vector<double>& minifepointdata, int time_step, 
double time, bool force_output); 
 

• Hint: example5_catalyst_adaptor.cpp 
– void getpointcoordinate(const int indices[3], const 

double spacing[3], double coord[3]); 
– void getcellpointids(const Box& local_box, const int 

indices[3], vtkIdType pointids[8]); 
90 



Example 5 – A Solution 

… 
  vtkNew<vtkUnstructuredGrid> grid; 
  grid->Initialize(); 
  vtkNew<vtkPoints> points; 
  points->SetNumberOfPoints( (local_box[0][1]-local_box[0][0]+1) * 
     (local_box[1][1]-local_box[1][0]+1)*(local_box[2][1]-local_box[2][0]+1) ); 
  double coord[3]; int indices[3]; vtkIdType id=0; 
  for(int iz=local_box[2][0]; iz<=local_box[2][1]; ++iz) 
      for(int iy=local_box[1][0]; iy<=local_box[1][1]; ++iy) 
        for(int ix=local_box[0][0]; ix<=local_box[0][1]; ++ix) { 
          int indices[3] = {ix, iy, iz}; 
          getpointcoordinate(indices, spacing, coord); 
          points->SetPoint(id++, coord); 
          } 
    grid->SetPoints(points.GetPointer()); 
… 
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Example 5 – A Solution (2) 
… 
  grid->Allocate( (local_box[0][1]-local_box[0][0]) * 
      (local_box[1][1]-local_box[1][0])*(local_box[2][1]-local_box[2][0]) ); 
    vtkIdType pointids[8]; 
    for(int iz=local_box[2][0]; iz<local_box[2][1]; ++iz) 
      for(int iy=local_box[1][0]; iy<local_box[1][1]; ++iy) 
        for(int ix=local_box[0][0]; ix<local_box[0][1]; ++ix) { 
          int indices[3] = {ix, iy, iz}; 
          getcellpointids(local_box, indices, pointids); 
          grid->InsertNextCell(VTK_HEXAHEDRON, 8, pointids); 
        } 
… 
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Field Information 

• Store information defined 
over grids 

• Stored in concrete 
classes that derive from 
vtkDataArray 
– vtkFloatArray 
– vtkIntArray 
– vtkDoubleArray 
– vtkUnsignedCharArray 
– … 
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vtkDataArray – Basis for vtkDataObject 
Contents  

• An array of n tuples 
• Each tuple has 

m components which are 
logically grouped together 

• Internal implementation is a 
pointer to an n x m block of 
memory 

• Data type determined by 
class 
 

• Two APIs : generic and 
data type specific 
 

tuple 0 

tuple n-1 

http://www.vtk.org/doc/nightly/html/classvtkDataArray.html 
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vtkDataArray 
• SetNumberOfComponents() – call first 
• SetNumberOfTuples() 

– For point data must be set to number of points 
– For cell data must be set to number of cells 

• SetArray() 
– If flat array has proper component & tuple ordering use existing 

simulation memory – most efficient 
– Can specify who should delete 
– VTK uses pipeline architecture so Catalyst libraries will NOT 

modify array values 

• SetTupleValue() – uses native data type 
• SetValue() – uses native data type 
• SetName() – array descriptor, e.g. velocity, density 

 http://www.vtk.org/doc/nightly/html/classvtkDataArray.html 
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vtkFieldData 

• Object for storing vtkDataArrays 
• vtkDataSet::GetFieldData() – arrays not 

associated with points or cells 
• Derived classes 

– vtkPointData – vtkDataSet::GetPointData() 
– vtkCellData – vtkDataSet::GetCellData() 

• vtkFieldData::AddArray(vtkDataArray*) 
• Specific arrays are normally retrieved by name 

from vtkFieldData 
– Uniqueness is not required but can cause unexpected 

results 
 http://www.vtk.org/doc/nightly/html/classvtkFieldData.html 
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Point Data and Cell Data 

 
 
 
 
 
 
 
 

Point data – 36 values Cell data – 25 values 
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Fortran90 Example 6 – Write It! 

• Subroutine signature: 
– runcoprocessor(dimensions, step, time, x)  

• Starting files: 
– ~/Examples/CatalystExampleCode/ 
  FortranPoissonSolver/FEFortranAdaptor.F90 
– ~/Examples/CatalystExampleCode/ 
  FortranPoissonSolver/FECxxAdaptor.cxx 

• Use xcp vector for source in 
FEFortranAdaptor.F90 
– Already ordered for our grid’s points 
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Fortran90 Example 6 – A Solution (1/2) 

 subroutine runcoprocessor(dimensions, step, time, x) 
  … 
  ! x is the array with global values, we need just this process's 
       ! values for Catalyst which will be put in xcp 
       allocate(xcp((extent(2)-extent(1)+1)*(extent(4)-extent(3)+1)*(extent(6)-extent(5)+1))) 
       call getlocalfield(dimensions, extent, x, xcp) 
 
       ! adding //char(0) appends the C++ terminating character 
       ! to the Fortran array 
       call addfield(xcp,"solution"//char(0)) 
       call coprocess() 
       deallocate(xcp) 
    end if 
  end subroutine runcoprocessor 

99 

~/Examples/CatalystExampleCode/FortranPoissonSolver/  
   example6/FEFortranAdaptor.F90 



Fortran90 Example 6 – A Solution (2/2) 

extern "C" void addfield_(double* scalars, char* name) 
{ 
  vtkCPInputDataDescription* idd = 
    vtkCPPythonAdaptorAPI::GetCoProcessorData()->GetInputDescriptionByName("input"); 
  vtkImageData* image = vtkImageData::SafeDownCast(idd->GetGrid()); 
  if (!image) 
    { 
    vtkGenericWarningMacro("No adaptor grid to attach field data to."); 
    return; 
    } 
  // field name must match that in the fortran code. 
  if (idd->IsFieldNeeded(name)) 
    { 
    vtkSmartPointer<vtkDoubleArray> field = vtkSmartPointer<vtkDoubleArray>::New(); 
    field->SetName(name); 
    field->SetArray(scalars, image->GetNumberOfPoints(), 1); 
    image->GetPointData()->AddArray(field); 
    } 
} 
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C++ Example 6 – Write It! 

• Still using function signature: 
– void coprocess(const double spacing[3], const Box& 

global_box, const Box& local_box,                 
std::vector<double>& minifepointdata, int time_step, 
double time, bool force_output); 

• Use vtkpointdata vector for source 
– Already ordered for our grid’s points 
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C++ Example 6 – A Solution 

… 
  std::vector<double> vtkpointdata; 
  getlocalpointarray(global_box, local_box, minifepointdata, vtkpointdata); 
  vtkSmartPointer<vtkDoubleArray> myDataArray = 
      vtkSmartPointer<vtkDoubleArray>::New(); 
  myDataArray->SetNumberOfComponents(1); 
  myDataArray->SetName("myData"); 
  myDataArray->SetArray(&(vtkpointdata[0]), vtkpointdata.size(), 1); 
  grid->GetPointData()->AddArray(myDataArray); 
… 
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Python Example 6 – Write It! 

• Write a function to add point and cell arrays to 
the grid 

• Use Dolfin vector for source 
– Based on numpy vectors 
– Ordered as the cells in the grid 
– In case of multidimensional arrays (vector fields) 

components are serialized : x1,y1,z1, x2,y2,z2, in a 
1D Dolfin vector 
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Python Example 6 – A Solution (1/2) 

def Values2VTKArray(values,n,name): 
 ncomps=len(values)/n 

 array=vtk.vtkDoubleArray() 

 array.SetNumberOfComponents(ncomps) 

 array.SetNumberOfTuples(n) 

 i=0 

 for x in values: 

  array.SetValue(i,x) 

  i+=1 

 array.SetName(name) 

 return array 

First, write a function to convert Dolfin vectors to n-component VTK arrays 

~/Examples/CatalystExampleCode/PythonDolfinExample/simulation-catalyst-step6.py 



Python Example 6 – A Solution (2/2) 

def AddFieldData(ugrid, pointArrays, cellArrays ): 

    npoints = ugrid.GetNumberOfPoints() 

    for (name,values) in pointArrays: 

        ugrid.GetPointData().AddArray(Values2VTKArray(values,npoints,name)) 

    ncells = ugrid.GetNumberOfCells() 

    for (name,values) in cellArrays: 

        ugrid.GetCellData().AddArray( Values2VTKArray(values,ncells,name) ) 

Then, we write a function adding arrays to the VTK grid 

while tstep < maxtimestep: 

    . . . 

    ugrid = Mesh2VTKUGrid( u1.function_space().mesh() ) 

    velocity = u1.compute_vertex_values() 

    pressure = p1.compute_vertex_values() 

    AddFieldData( ugrid, [ ("Velocity",velocity) , ("Pressure",pressure) ] , [] ) 

    coProcess(ugrid,t,tstep) 

Finally, before calling AddFieldData, we request Dolfin  to produce flattened  
representation of fields 



Multiple Grids 
• Use something that derives from 

vtkCompositeDataSet to group multiple 
vtkDataSets together 
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vtkMultiBlockDataSet 

• Most general way of 
storing vtkDataSets and 
other 
vtkCompositeDataSets 

• Block structure must be 
the same on each 
process 

• Block is null if data set is 
on a different process 

• SetNumberOfBlocks() 
• SetBlock() 

 

 http://www.vtk.org/doc/nightly/html/classvtkMultiBlockDataSet.html 
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vtkMultiPieceDataSet 
• Way to combine multiple vtkDataSets of the 

same type into a single logical object 
– Useful when the amount of pieces is unknown a priori 

• Must be contained in a vtkMultiBlockDataSet 
• SetNumberOfPieces() 
• SetPiece() 

 

http://www.vtk.org/doc/nightly/html/classvtkMultiPieceDataSet.html 
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AMR Data Sets 
• Classes derive from vtkUniformGridAMR 
• Concept of grid levels for changing cell size 

locally 
• Uses only vtkUniformGrids  

– vtkNonOverlappingAMR – no blanking used since no 
data sets overlap 

– vtkOverlappingAMR – vtkUniformGrids overlap and 
use blanking 
 

 
 

 
http://www.vtk.org/doc/nightly/html/classvtkUniformGridAMR.html 
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Grid Partitioning 
• For unstructured grids and polydatas 

– Single data set per process – use as is 
– Multiple data sets per process – choice of combining 

or not depends on memory layout 
 

• For topologically structured grids 
– Must be partitioned into logical blocks 
– SetExtent()  

• Index of first and last point in each direction  
• Will be different on each process 

– vtkCPInputDataDescription::SetWholeExtent() – 
same on each process 
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Advanced Topics 

• Zero-copy for VTK arrays 
– Reuse existing memory in layout different than 

standard VTK arrays 
• Hard-coded C++ pipelines 

– Removes dependency on Python 
– Use simulation input parameters to remove 

requirement that users create pipelines in ParaView 
• Ghost information 
• CMake for automatic C++ and Fortran function 

name mangling 
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Gratuitous 
Catalyst  
Images 
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ParaView Catalyst for 
Simulation Users 
 



Creating Catalyst Output 

Two main ways: 
• Create and/or modify Python scripts 

– ParaView GUI plugin to create Python scripts 
– Modification with knowledge of ParaView Python API 

 
• Developer generated “canned” scripts 

– User provides parameters for already created 
Catalyst pipelines 

– User may not even need to know ParaView 
– See ParaView Catalyst User’s Guide 
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Create Python Scripts from ParaView 

• Use the Catalyst script generator GUI plugin 
• Similar to using ParaView GUI interactively 

– Setup desired pipelines 
– Ideally, start with a representative data set from the 

simulation 
• Extra pipeline information to tell what to output 

during simulation run 
– Add in data extract writers 
– Create screenshots to output 
– Both require file name and write frequency 
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Building the miniFE Example 

• cd ~/Examples/miniFE-2.0_ref_Catalyst 
• mkdir adapter_build 
• cd adapter 
• cp examples/live_catalyst_adaptor.cpp 

catalyst_adaptor.cpp 
• cd ../adapter_build 
• ccmake ../adapter -

DParaView_DIR:PATH=~/ParaView4.2/build_mesa 
• make 
• cd ../src 
• make 
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In Situ Demo 

• Create a ParaView Catalyst Python pipeline 
script 
– Specify desired outputs from run 
– Export the script 

 

• In the ~/Examples/miniFE-2.0_ref_Catalyst/src 
directory, run the script with miniFE 
– ./miniFE.x script_names=<file name> 

 
 

• Examine results 
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Use Catalyst to Write Out Grid 

• Need something to start with 
• Grid of the same type 
• Fields of the same type 
• The closer to the actual simulation the better 
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Run It! 

• Go to ~/Examples/miniFE-2.0_ref_Catalyst/src 
 

• First time use gridwriter.py 
– Simple Catalyst Python pipeline to write out the full 

grid and fields every time step 
– Run with “./miniFE.x script_names=gridwriter.py” 
– Output files will be filename_*.pvti 
– Default grid dimensions will be 11 points in each 

direction 
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In Situ Demo – Load Plugin Step 

Called CoProcessingPlugin for ParaView 4.1 and earlier 
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In Situ Demo – New Plugin Menus 
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In Situ Demo – Creating a Catalyst 
Python Script 

• Load output file 
filename_*.pvti from 
previous run 
 
 
 

• Create desired pipeline 
 

 
 
 
 
 
 
 

 

122 



In Situ Demo – Adding in Writers 
• Only valid writers 

available in Writers menu 
• Parameters: 

– File Name – %t gets 
replaced with time step 

– Write Frequency 
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In Situ Demo – Exporting the 
Script 
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In Situ Demo – Select Inputs 
• Usually only a single input but can have multiple 

inputs 
• Each pipeline source is a potential input 
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In Situ Demo – Match Up Inputs 
• Source name (e.g. “filename_10.pvti”) needs to 

be matched with string key in adaptor (e.g. 
“input” which is the default convention for single 
inputs) 
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In Situ Demo – Generating an Image 

• Parameters/Options: 
– Live visualization 
– Rescale to Data 

Range (all images) 
– Individual images 

• Image Type 
• File Name 
• Write Frequency 
• Magnification 
• Fit to Screen 

• %t gets replaced with 
time step 
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In Situ Demo – Generating Two Images 

• Requires two views in 
ParaViews GUI 
– Use Next View and 

Previous View to 
toggle between GUI 
views 
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def DoCoProcessing(datadescription): 
   …  
    input = CreateProducer( datadescription, "input" ) 
  
    ParallelMultiBlockDataSetWriter1 = CreateWriter( 
XMLMultiBlockDataWriter, "filename_%t.vtm", 1) 
 

In Situ Demo – Write 
Out the Script 
• Generated script will look 

something like this 
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In Situ Demo – Run the Script 

• Put the generated Python script in 
~/Examples/InSituRunDemo directory 

  
• Run with “./miniFE.x 

script_names=<outputscript>” 
– Can use MPI to run with more processes 
– Change grid size with nx=, ny=, nz= command line 

arguments 
– Run multiple scripts with comma separated list 

script_names=<script1>,<script2>,<script3> 
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Live In Situ Analysis and Visualization 

• Everything before this was “batch” 
– Preset information with possible logic added 

 
• Functionality for interacting with simulation data 

during simulation run 
– When exporting a Python script, select “Live 

Visualization” 
– During simulation run choose the “Tools→Connect to 

Catalyst” GUI menu item 
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Two Ways for Live In Situ Analysis and 
Visualization 

• Without blocking 
– Simulation proceeds while the user interacts with the 

data from a specific time step 
– “At scale” mode 

• With blocking (new in ParaView 4.2) 
– Simulation is blocked while the user interacts with the 

data 
– “Debugging” mode 

• Can switch between interactive and batch during 
run as well as disconnecting from the run 
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Live In Situ Example 

• Need to “lengthen” the simulation time 
– Increase nx, ny and nz 

 
• Run as before with “./miniFE.x 

script_names=<outputscript>” 
– Must have Catalyst “Live Visualization” enabled 

• Start ParaView and select Tools→Connect to 
Catalyst 
– Select port (22222 is default) 
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Live In Situ Example 

• Only transfer requested 
data from server 
(simulation run) to 
client 
– ExtractSurface1 is 

already getting extracted 
• Use               on client   

to stop transferring to 
client 

• Click on        to transfer 
to client from Catalyst 
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ParaView Cinema + Catalyst 

• Image output is orders magnitude less than an 
entire data set 
– Helios: full data set – 448 MB, surface of blades – 2.8 

MB, image – 71 KB 
• Use Catalyst to make a set of images at each 

time step with small output changes (rotations, 
slice planes locations, iso-surfaced variables & 
values, etc.)  

• Use a web-browser to view images later  
• In ParaView 4.2 as beta functionality 
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ADIOS Writer 

• Improved IO for at scale HPC runs 
– https://www.olcf.ornl.gov/center-projects/adios/ 

• Separate PETTT project to study scaling IO on 
Garnet & Copper DSRCs 
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Building ParaView 
Catalyst 
 



Build Considerations Overview 

• Shared library build 
– Easier for development but can kill the IO system on 

HPC machines for large scale runs 
 

• Static library build 
– Freezing Python allows it to be built statically into the 

executable instead of having it behave similar to 
shared libraries 
 

• Mesa 
– When window manager isn’t available or don’t want 

render windows popping up for image generation 140 



ParaView Catalyst Editions 

• Doing a full ParaView build gives full Catalyst 
functionality 
– Also can add 150 MB or more to the executable size 

depending on ParaView configuration 
• Most people use a small subset of VTK and 

ParaView filters for analysis and visualization 
• Catalyst editions allow simpler ways to remove 

unneeded functionality 
– Can get Catalyst library size down to 15 to 30 MB 

depending on configuration  
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Preconfigured ParaView Catalyst 
Editions 

• Base – a minimal set of functionality to build 
other editions from but not meant for use on its 
own 

• Essentials – base + several of the most popular 
filters 

• Extras – base + essentials + parallel XML writers 
and a couple more filters 

• Rendering – coming soon… 
• Python version of each available as well 
• Available at www.paraview.org/download 142 



Online Help 
• Catalyst User’s Guide: 

– http://paraview.org/Wiki/images/4/48/CatalystUsersGuide.pdf  

• Email list:  
– paraview@paraview.org  

• Doxygen: 
– http://www.vtk.org/doc/nightly/html/classes.html 
– http://www.paraview.org/ParaView3/Doc/Nightly/html/classes.html 

• Sphinx: 
– http://www.paraview.org/ParaView3/Doc/Nightly/www/py-doc/index.html  

• Websites: 
– http://www.paraview.org  
– http://catalyst.paraview.org 

• Examples:  
– https://github.com/acbauer/CatalystExampleCode  
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